
LG_LMS2-4

IAR Systems®

Licensing Guide

LG_LMS2-4



LG_LMS2-4

COPYRIGHT NOTICE
© 2011–2014 IAR Systems AB.

No part of this document may be reproduced without the prior written consent of IAR 
Systems AB. The software described in this document is furnished under a license and 
may only be used or copied in accordance with the terms of such a license.

DISCLAIMER
The information in this document is subject to change without notice and does not 
represent a commitment on any part of IAR Systems. While the information contained 
herein is assumed to be accurate, IAR Systems assumes no responsibility for any errors 
or omissions.

In no event shall IAR Systems, its employees, its contractors, or the authors of this 
document be liable for special, direct, indirect, or consequential damage, losses, costs, 
charges, claims, demands, claim for lost profits, fees, or expenses of any nature or kind.

TRADEMARKS
IAR Systems, IAR Embedded Workbench, C-SPY, visualSTATE, The Code to Success, 
IAR KickStart Kit, I-jet, I-scope, IAR, and the logotype of IAR Systems are trademarks 
or registered trademarks owned by IAR Systems AB.

Microsoft and Windows are registered trademarks of Microsoft Corporation.

Adobe and Acrobat Reader are registered trademarks of Adobe Systems Incorporated.

All other product names are trademarks or registered trademarks of their respective 
owners.

EDITION NOTICE 

Fourth edition: November 2014

Part number: LG_LMS2-4

Internal reference: LS 2.1x, ISUD.



Contents
Preface ......................................................................................................................  5

Who should read this guide ................................................................. 5

What this guide contains ....................................................................... 5

Further information .............................................................................. 6

Document conventions .......................................................................... 6

Typographic conventions ..................................................................... 6

Introduction ..........................................................................................................  9

How IAR Systems licensing works .................................................... 9

License types ...................................................................................... 10

Introduction to the IAR License Manager ................................... 10

Briefly about the IAR License manager ............................................ 10

Briefly about the License Wizard ...................................................... 10

Network licenses ..................................................................................... 10

Using different versions of license servers ........................................ 11

The IAR License Server package ....................................................... 11

Your IAR Systems product ................................................................ 11

Clients with commuter authorization ................................................. 12

System requirements .......................................................................... 12

Network requirements for the license server ..................................... 12

Installing a product with a network license ........................................  13

Installing a product using a network license ............................... 13

Installing the IAR License Server ...................................................... 13

Activating the license ......................................................................... 18

Installing an IAR Systems product on client computers .................... 22

License management .......................................................................................  25

Managing your licenses ......................................................................... 25

Switching between different licenses for a product ........................... 25

Checking out a product for commuter authorization ......................... 26

Maximum number of commuter authorizations ................................. 26
LG_LMS2-4

 3



4

Activating your license while offline ................................................. 26

Transferring your license to another computer while offline ............ 31

Choosing a network license manually ............................................... 32

Updating a product that uses a network license ................................. 32

Adding more users to a network license ............................................ 35

Transferring network licenses ............................................................ 35

Manually starting and stopping the license server ............................. 36

Reserving user groups for network licenses ............................... 38

Logging license server activities ....................................................... 39

Enabling the logging .......................................................................... 39

Specifying the size of the log files ..................................................... 39

Backing up the log files ..................................................................... 39

Disable backing up log files ............................................................... 40

The log file format ............................................................................. 40

Reference information on the IAR License Manager .....................  43

Reference information ......................................................................... 43

IAR License Manager main window ................................................. 43

Available Renewals dialog box .......................................................... 47

Check for License Renewals dialog box ............................................ 48

License Details dialog box ................................................................. 49

Servers dialog box .............................................................................. 51

Licensing concepts ...........................................................................................  53

Index .......................................................................................................................  55
LG_LMS2-4

Licensing Guide



Preface
Welcome to the Licensing Guide. It contains detailed information about how 
to install an IAR Systems product that uses a network license and how to 
manage your licenses. You will also get detailed reference information on the 
IAR License Manager.

For information about how to install and license an IAR Systems product that 
uses a mobile or PC-locked single-user license, see the Installation and Licensing 
Quick Reference booklet in your product box.

Who should read this guide
You should read this guide if you:

● Are about to install a Network license and need more information about installation 
and licensing than is available in the Quick Reference booklet

● Have a Network license and are about to install the license server

● Are about to upgrade your existing license

● Need to transfer your license to another computer

● Are about to use the IAR License Manager.

What this guide contains
This guide contains these chapters:

● Introduction gives a general introduction to the installation and licensing procedure 
and describes the differences between the different license types with the main 
focus on network licenses.

● Installing a product with a network license gives a step-by-step description of how 
to install both the license server software and the client software in a multi-user 
environment. This chapter also describes how to upgrade both the license server and 
your IAR Systems product clients.

● License management gives step-by-step descriptions of how to perform some 
typical tasks for network licenses.

● Reference information on the IAR License Manager gives reference information on 
the IAR License Manager—a tool for managing your licenses.
LG_LMS2-4
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Document conventions
● Licensing concepts lists and describes terms related to licensing in general.

FURTHER INFORMATION

If this guide does not answer your questions or solve your problems concerning the 
installation or licensing, you can:

● Read the release notes for recent information that might not be included in this 
guide. The release notes are available in the Information Center and on the product 
installation media.

● See the technical notes on the Technical Support pages on the IAR Systems web 
site: www.iar.com/support

● Contact IAR Systems Technical Support for technical support. Information about 
how to access our Technical Support can be found on the IAR Systems web site: 
www.iar.com/support.

Be prepared to provide the following information: your license number, the type of 
license lock you use, when and where you purchased the product, and a detailed 
description of the problem.

Document conventions 
When, in the IAR Systems documentation, we refer to the programming language C, the 
text also applies to C++, unless otherwise stated.

When referring to a directory in your product installation, for example doc, the full path 
to the location is assumed, for example

c:\Program Files\IAR Systems\Embedded Workbench 6.n\cpuname\doc 

or 

c:\Program Files\IAR Systems\visualSTATE 7.n\doc.

TYPOGRAPHIC CONVENTIONS

The IAR Systems documentation set uses the following typographic conventions:

Style Used for

computer • Source code examples and file paths.
• Text on the command line.
• Binary, hexadecimal, and octal numbers.

parameter A placeholder for an actual value used as a parameter, for example 
filename.h where filename represents the name of the file.

Table 1: Typographic conventions used in this guide
LG_LMS2-4
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[option] An optional part of a command.

[a|b|c] An optional part of a command with alternatives.

{a|b|c} A mandatory part of a command with alternatives.

bold Names of menus, menu commands, buttons, and dialog boxes that 
appear on the screen.

italic • A cross-reference within this guide or to another guide.
• Emphasis.

… An ellipsis indicates that the previous item can be repeated an arbitrary 
number of times.

Identifies helpful tips and programming hints.

Identifies warnings.

Style Used for

Table 1: Typographic conventions used in this guide (Continued)
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Introduction
This chapter introduces the IAR Systems licensing system. It gives an overview 
of the installation and license activation procedure, and of the different license 
types.

How IAR Systems licensing works
Each product from IAR Systems comes with a software license.

When you start your IAR Systems product for the first time after you have installed it, 
you activate your license by entering your License Number and registering the license. 
A license wizard will guide you through the process:

In the welcome letter of your product package, you will find a license number. The 
automatic activation will give you a Startup license that allows you to start using the 
product immediately after installation and 30 days onward.

When you have finished your purchase, you will be able to activate your permanent 
license. You are now also entitled to up to one year of free updates and prioritized 
technical support, depending on your purchased product.

A license manager is installed together with your IAR Systems product to help you 
manage your licenses. For more information about how to use the IAR License 
Manager, see License management, page 25.
LG_LMS2-4
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Introduction to the IAR License Manager
LICENSE TYPES

There are three kinds of permanent licenses: 

● Mobile license—a single-user license locked to a dongle (hardware lock)

● PC-locked license—a single-user license locked to the computer where the software 
is installed

● Network license for multiple users.

This guide describes the Network license and how to manage it. For more information 
about the Mobile and PC-locked license types, see the Quick Reference booklet supplied 
in the product package.

Introduction to the IAR License Manager
This section introduces you to the IAR License Manager.

BRIEFLY ABOUT THE IAR LICENSE MANAGER

The IAR License Manager is a program—automatically installed when you install your 
IAR Systems product or the IAR License Server—that you can use to administrate your 
licenses.

The IAR License Manager is local to a specific installation directory and automatically 
detects all IAR Systems products that use this version of the licensing system and are 
installed in the same directory.

Start the IAR License Manager either from the Windows Start menu or from the Help 
menu in your IAR Systems product.

BRIEFLY ABOUT THE LICENSE WIZARD

The License Wizard leads you step by step through the license activation process. It will 
start automatically when you start your IAR Systems product if there are installed 
products without valid licenses. You can also start it from the License menu in the IAR 
License Manager.

Network licenses
A Network license is a multi-user license that is located on a license server computer. A 
license server computer is a PC with the IAR License Server installed. Individual 
installations of IAR Systems products are installed on other computers (clients) in the 
same network. 
LG_LMS2-4
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Introduction
The network license makes it possible to use your IAR Systems product from any of the 
client computers on the network. The network license allows for a maximum number of 
concurrent users, and the license server keeps track of the current number of users.

The network license is locked to the computer where the license server is installed, 
either to the computer itself or to an attached dongle. With the dongle, you can easily 
transfer the license server to a different server computer.

The license server is generic and you can use it for all IAR Systems products you install.

USING DIFFERENT VERSIONS OF LICENSE SERVERS

Your IAR Systems product requires version 2.x of IAR License Server. Note that some 
IAR Embedded Workbench products require version 1.4x or older of the license server. 
A new and an old server cannot coexist on the same computer unless virtual machines 
are used.

THE IAR LICENSE SERVER PACKAGE

When you order a network license, you receive:

● One installation media with the IAR License Server

● One dongle (only if explicitly ordered)

● One installation media with your IAR Systems product.

The license server consists of two components:

● The IAR License Manager, which is used for administrating licenses. The IAR 
License Manager is also installed with your IAR Systems product to administrate 
licenses on the client computers.

● The Sentinel RMS License Manager, which is the actual license server.

Install the license server on a computer that you want to use for the license server.

YOUR IAR SYSTEMS PRODUCT

The IAR Systems product can be installed on as many client computers as you want.

Using a network license, the IAR Systems product requests permission to run from the 
license server each time you perform an activity that requires a license, for example 
compiling and linking.

When the activity is finished, the permission to use the network license remains locked 
to that client for another 30 minutes before it is released to another client. In the IAR 
License Manager you can view the status of the license.
LG_LMS2-4
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Network licenses
CLIENTS WITH COMMUTER AUTHORIZATION

A network license includes a commuter feature, which makes it possible to use your IAR 
Systems product for a limited number of days without being connected to the license 
server. For more information, see Checking out a product for commuter authorization, 
page 26.

SYSTEM REQUIREMENTS

For information about systems requirements:

● For client computers, see the Release notes on the installation media

● For the IAR License Server computer (network licenses only), see the Release notes 
on your IAR License Server installation media.

Note: To install and activate the product, you must have administrator privileges on the 
computer and an internet connection. If IAR License Manager cannot get access to the 
internet, see Activating your license while offline, page 26.

NETWORK REQUIREMENTS FOR THE LICENSE SERVER

If you have a network license, each client installation will automatically search for 
license servers on the subnet.

The client–server communication is handled via the UDP protocol at port 5093 on an IP 
network.

If a firewall or network bridge is installed on the license server computer, for example 
Windows Firewall, UDP packets must be allowed to be routed through server port 5093.

In network configurations where the broadcast function is not available or the license 
server is on a different subnet, you must manually point out the server from the client. 
For information about how to do this, see Servers dialog box, page 51.

UDP broadcast packets at port 5093 are also used every time your IAR Systems product 
is started and periodically for as long as the IAR License Manager is running. The 
broadcasts are made to find available license servers on the network. No broadcasts are 
made during the time that a licensed product is being used.

The IAR License Manager uses the https communication protocol to fetch license keys 
from IAR Systems. The Windows settings for internet proxy are used.
LG_LMS2-4
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Installing a product with a 
network license
This chapter gives information to the system or network administrator about 
how to install the IAR License Server on the designated server and the IAR 
Systems products on the client computers.

For information about network licenses, see Network licenses, page 10.

Installing a product using a network license
The recommended way to install a product with a network license is the following 
three-stage procedure:

1 Install the IAR License Server on a server computer.

2 Activate and register the license using the IAR License Manager on the server.

3 Install your IAR Systems product on the client computers and start using the network 
license.

Note: To install products from IAR Systems, you must have administrator privileges to 
the system.

Important: If you wish to add a network license to an already installed IAR License 
Server, go directly to Activating the license, page 18, for instructions. Ignore the 
installation procedure described below.

INSTALLING THE IAR LICENSE SERVER

Note: Unless you use a dongle, it is important that you decide from the beginning 
which computer to use for the license server, because the license server will be locked 
to that computer.

1 Choose a suitable server computer for the license server; see the release notes on your 
license server installation media regarding system requirements.

2 Remove any dongles.

3 Insert the IAR License Server installation media. The installation program should start 
automatically. If it does not, run the autorun.exe program from the installation 
media.
LG_LMS2-4
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Installing a product using a network license
4 Click Install the IAR License Server. This will first install the IAR License Manager 
and then immediately continue with the Sentinel RMS License Manager.

5 Click Next to confirm that you have read and understood the license agreement.

6 Choose the destination folder where the IAR License Manager will be installed.
LG_LMS2-4
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7 Select the folder for the program icon on the Start menu.

8 When the IAR License Manager has been installed, the installation of the Sentinel 
RMS License Manager starts.

9 Click Next to confirm that you have read and understood the RMS license agreement.
LG_LMS2-4
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Installing a product using a network license
10 Fill in the customer information.

11 Choose a destination folder where the license server will be installed. The default 
directory is C:\Program Files\Common Files\SafeNet Sentinel\Sentinel 
RMS License Manager.

12 On the Setup Type page, select either Complete or Custom (by default, this does not 
install the dongle drivers).
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13 On the next page you should unblock UDP traffic on port 5093, which is necessary for 
the client computers to access the server.

14 Click Install to install the Sentinel RMS License Manager.

Normally, you do not need to start the license server manually. It will automatically start 
after the installation and restart every time you restart the computer. If you for some 
reason need to start the license server manually, see Manually starting and stopping the 
license server, page 36.
LG_LMS2-4
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Installing a product using a network license
ACTIVATING THE LICENSE

Before you can use your network license, you must activate it.

1 On the license server computer, start the IAR License Manager from the Windows 
Start menu.

2 Choose License>Activate License.

Alternatively, if the IAR License Manager cannot get access to the internet, you can 
renew your license by selecting Offline Activation from the License menu and enter 
your license number.

3 If you have a dongle, attach it to your computer.

4 Type your license number and click Next. The license number can be found in the 
Welcome letter.
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Installing a product with a network license
5 In the next step, click Register. 

6 The License Wizard opens a registration web page at IAR Systems where you register 
your license. 

When you have completed the registration form, an email will be sent to the address you 
specified. Open the email when you receive it and click on the link in this email to verify 
the registration. The registration procedure is now completed. 

Click Next in the License Wizard to continue with the license activation.
LG_LMS2-4
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Installing a product using a network license
7 Click Next to confirm that you want to activate the license on the computer you are 
using. 

8 If your network license is using a dongle, you must now to lock the license to the 
dongle. (If your license will not use a dongle, skip this step.) Connect the dongle to 
your computer, and make sure that no other dongle is connected.

Alternatively, if your dongle has not arrived, you can temporarily lock your license to 
your computer. Select the corresponding check box.

Note: It is possible to lock the license to another dongle than the one provided with the 
product package, for example, if you want to lock several products to the same dongle. 
In that case, carefully consider the consequences. Once the dongle is confirmed, the lock 
cannot be undone.
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9 The License Wizard now confirms your license details. Click Next to finish the 
activation.

Note: Your permanent license might include a time-limited evaluation of features that 
are not part of the license you have bought.

10 In the IAR License Manager, choose View>Network Licenses to view the installed 
licenses.

11 You can now close the IAR License Manager. The server will be running in the 
background and you can at any time start the manager again to view or administrate the 
licenses.

12 You will receive a notification by email when the permanent license is available.

To get your permanent license, perform the following steps on your license server 
computer:

1 Start the IAR License Manager from the Windows Start menu.

2 On the License menu, choose Check for License Renewal and follow the instructions.
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Installing a product using a network license
Alternatively, if the IAR License Manager cannot get access to the internet, you can 
renew your license by selecting Offline Activation from the License menu and enter 
your license number.

INSTALLING AN IAR SYSTEMS PRODUCT ON CLIENT 
COMPUTERS

The following steps should be repeated on each client computer.

If you already have the new version of the product installed (an evaluation version), go 
directly to step eight.

1 Insert the  installation media. The installation program should start automatically. If it 
does not, run the autorun.exe program from the installation media.

2 Click Install... to start the installation.

3 Read and accept the license agreement when prompted.

4 If prompted, select either a Complete or a Custom installation:

If you select Custom, select the components you want to install in the next dialog box.
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Installing a product with a network license
Note that this step does not always apply.

5 Accept the default installation directory or specify a directory of your choice:

6 Choose a folder in the Windows Start menu where you want to place the IAR Systems 
product start shortcut.

7 Review the settings for the installation and click Install to install the program files.

You are now finished with the IAR Systems product installation.
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Installing a product using a network license
Make sure to repeat the steps above on each client computer where you want to be able 
to run your IAR Systems product.

8 When you first start your IAR Systems product on a client computer, it will find the 
license server and suggest that you use it. If the client does not find the license server 
automatically, you can point it out manually, see Servers dialog box, page 51.

9 You can now start using your IAR Systems product.

Note: If you are upgrading from a size-limited IAR Embedded Workbench version, 
make sure to perform a Rebuild All command when you build your project for the first 
time using the new version.
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License management
This chapter describes how to perform some tasks related to license 
management.

Managing your licenses
This section gives information about some tasks that you might need to perform. For 
some of the tasks there are also step-by-step descriptions.

More specifically, you will get information about:

● Switching between different licenses for a product

● Checking out a product for commuter authorization

● Maximum number of commuter authorizations

● Activating your license while offline

● Transferring your license to another computer while offline

● Choosing a network license manually

● Updating a product that uses a network license

● Adding more users to a network license

● Transferring network licenses

● Manually starting and stopping the license server.

See also the Quick Reference booklet for information about transferring a license to 
another computer.

SWITCHING BETWEEN DIFFERENT LICENSES FOR A 
PRODUCT

You can have several licenses for the same product installed on your computer. The 
license that was last activated will be used. To switch to an older version of the license, 
to another product variant, or to a network license, follow this procedure:

1 In the IAR License Manager, choose View>Product List and double-click the product 
to display the License Details dialog box.

2 Select the license you want to use from the Selected license drop-down list.
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Managing your licenses
CHECKING OUT A PRODUCT FOR COMMUTER 
AUTHORIZATION

To check out a license from a network server:

1 Start the IAR License Manager.

2 Right-click on the product and choose Check Out.

3 In the Check Out dialog box that is displayed, specify for how many days (maximum 
15 days) you want to check out a product with commuter authorization.

You can now use the product without being connected to the license server.

4 To terminate the commuter authorization before it expires automatically, right-click on 
the product and choose Check In.

The license will automatically be returned after the specified number of days.

MAXIMUM NUMBER OF COMMUTER AUTHORIZATIONS

To set the maximum number of commuter authorizations to be, for example, 25% of the 
total number of licenses, use the LSERVOPT environment variable with the -com option 
on your license server computer:

LSERVOPTS=-com 25

ACTIVATING YOUR LICENSE WHILE OFFLINE

To activate your license even if the IAR License Manager cannot access the internet:

1 In the IAR License Manager, choose License>Offline Activation.
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2 In the wizard that appears, type your license number to generate an activation 
information file and click Next.

3 On the next page, specify whether the license should be locked to your computer or to 
a dongle. If your license should be locked to a dongle, but you have not received it yet, 
select Yes, but I have not received the dongle yet. You will then be able to lock the 
license temporarily to your computer while you wait for the dongle.
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Managing your licenses
4 If you chose to lock the license to a dongle directly (by selecting Yes on the previous 
page) you will be asked to connect the dongle before proceeding.

Connect the dongle and click Refresh dongle list.

5 Next, specify where to save the activation information file.
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6 Next, the wizard displays the URL https://register.iar.com/activate.

7 Go to a computer with internet access and browse to that web page. There you will be 
able to upload the generated activation file.
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Managing your licenses
8 If you have not registered your license you will be asked to do that before proceeding.

9 At the end of the activation process you will be able to download an activation response 
file.

Bring that file to the computer where you want to use your license.
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10 On the computer where you want to use your license, click Next in the wizard. Browse 
to the activation response file and click Next again.

You have now activated your license.

11 If you have temporarily locked your license to the computer and finally receive your 
dongle, repeat the offline activation, but choose to lock the license to the dongle.

12 When your license has been approved by IAR Systems, repeat the offline activation 
again to finally activate your permanent license.

TRANSFERRING YOUR LICENSE TO ANOTHER COMPUTER 
WHILE OFFLINE

A transfer involves deactivating and activating the license. Note that this procedure does 
not apply to Mobile licenses. For information about online license transfers, see the 
Quick Reference booklet.

1 On a computer with internet connection, go to 
https://register.iar.com/deactivate.

2 Type the license number you want to deactivate.

3 As a response you will get a deactivation permission file to download. Bring that file to 
your computer.

4 In the IAR License Manager, choose License>Offline License Transfer.

5 In the dialog box that appears, locate the permission file and click OK. A deactivation 
confirmation file will now be created.

6 Bring that file to the computer with an internet connection and return to the web page. 

7 Upload the deactivation ticket and your license is now ready to be activated on another 
computer.
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Managing your licenses
CHOOSING A NETWORK LICENSE MANUALLY

1 From the IAR License Manager, choose Licence>Use Network License to open the 
wizard.

2 In the list, select the server that you want to use and click Next:

3 Alternatively, if the server is not in the list, click Add a server. In the dialog box that 
appears, click Add and type the name or IP number of your server:

Note: Entering an incorrect server name might slow down the IAR License Manager.

Click OK to return to the wizard.

4 In the wizard, select the right server and click Next.

UPDATING A PRODUCT THAT USES A NETWORK LICENSE

To update a product that uses a network license, follow this three-stage procedure:

● Updating the IAR License Server, page 33. This step is only applicable if you have 
received an update of the IAR License Server in addition to the updated IAR 
Systems product.
LG_LMS2-4

Licensing Guide



License management
● Renewing a network license, page 34.

● Updating your IAR Systems product, page 34.

A product update is performed on the same computer where the previous version of the 
product is installed. The same license type and license lock are used after you have 
installed the update.

Updating the IAR License Server

If you have received an update of the license server, perform the following steps on the 
computer where you have the current license server installed.

Note: The installation procedure will shut down the license server and make all network 
licenses temporarily unavailable.

The setup program will uninstall the old version of the license server.

Follow the instructions in Installing the IAR License Server, page 13.

You are now finished with the IAR License Server update.
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Managing your licenses
Renewing a network license

When you receive a product update, your license must be renewed.

Note: The network licenses should not have any commuter authorizations checked out 
while the license is renewed.

1 Start the IAR License Manager on the license server computer.

2 In the Check for License Renewals dialog box that is displayed, select the license for 
which you want to check for renewals. 

Click Check selected licenses. The IAR License Manager contacts IAR Systems to 
check whether there are any renewals available for the selected license.

3 The Available Renewals dialog box is displayed and lists the licenses for which there 
are new licenses available. Make sure to select the license you want to renew and click 
Renew selected.

4 On the client computers, you must restart your IAR Systems product or start the IAR 
License Manager to make it detect the renewed licenses.

You are now finished and the updated license can be used.

Updating your IAR Systems product

Before you install your updated IAR Systems product on the client computers, decide 
whether you wish the update to completely replace your existing product installation, or 
whether you wish to keep your existing installation and install the update in another 
directory.

If you want to use multiple versions in parallel, make sure to install the new version in 
a different directory.
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If you wish to replace your existing installation, first do as follows:

● Make copies of any product files that you have modified in your existing 
installation. These files will otherwise be overwritten. Your own files will remain 
intact.

● Uninstall the current version of the product.

● If you are using IAR Embedded Workbench, uninstall the runtime library source 
code (this step is only applicable if such source code has previously been installed).

Then follow the instructions in Installing an IAR Systems product on client computers, 
page 22, for each client computer with the previous version of your IAR Systems 
product installed, that you want to update.

You are then finished with the  update.

ADDING MORE USERS TO A NETWORK LICENSE

If the number of concurrent users permitted by your network license is not sufficient, 
you can add more users to the license. To do this, you must contact your software 
distributor or IAR Systems to purchase an extended network license.

You will get an email notification when your purchase is finished. To activate your 
license with the new entitlements, perform one of these steps:

● Renewing a network license—looking for renewals for all activated licenses on the 
computer. If you have many licenses installed this might take some time (roughly up 
to one minute per license number). In this case, it might be better to perform the 
second step instead.

● Activating the license—renewing a specific license. You will need to specify the 
same license number as when the original license was activated. One advantage 
with this alternative is that only that license number is checked. This option can also 
be used if renewals fail due to, for example, a changed locking criterion.

TRANSFERRING NETWORK LICENSES

A network license can only be transferred to another server computer if the license is 
locked to a dongle. If you must transfer a network license that is locked to the server 
computer, you must contact IAR Systems.

To transfer the network licenses to a new license server computer, for example in the 
case of server failure, do as follows:

1 Install the IAR License Server on the new computer as described in Installing the IAR 
License Server, page 13. Do not activate the license or register the product.

2 Connect the dongle to the new license server computer.
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3 Start the IAR License Manager and activate your product, using the license number, 
see Activating the license, page 18. If you have more than one product, you must repeat 
this step for each license number.

4 On the client computers, start the IAR License Manager and choose the new license 
server as the license provider:

● Choose License>Use Network License

● Select your product and click Next

● Select the new license server and click Next.

You have now transferred the license server to the new computer.

MANUALLY STARTING AND STOPPING THE LICENSE 
SERVER

Normally, you do not need to start or stop the license server manually. It starts 
automatically when the computer is started. But if you for some reason need to start it 
manually, it is possible.

The license server runs as a Windows service. To find out if it is running, you can check 
the Windows list of services. How to display that list depends on which Windows 
version you are using. The service is called Sentinel RMS License Manager.

The executable file for the service is located where you installed the Sentinel RMS 
License Manager during the installation of the IAR License Server Tools. The default 
directory depends on Windows version and language, but would typically be something 
like this: C:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager
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In that directory there is a subdirectory WinNT where the server files are located. The 
name of the server executable file is Lservnt.exe. To start and stop it, you run 
loadls.exe (which requires administrator privileges).

Click Add or Remove to start or stop the service. If you accidentally click Add when 
the service is already running, or Remove when the service is not running, your will get 
an error message.
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Reserving user groups for network licenses
You can create a reservation file that specifies groups of users that have exclusive right 
to use a feature, and groups that may not use a feature.

To reserve a user group:

1 Edit the user group file using a text editor. Use this file syntax:

feature_name,feature_version:group_name:reserved_tokens:user_1 
... user_N

where:

For example, this file will make the server hold two tokens exclusively for the users at 
the workstations PC-ADAM and PC-ADA, for the compiler and debugger features, 
while the user of PC-GUEST will be unable to use the specified features at all:

XXX.EW.COMPILER_STD,1.01:include_grp:2:$PC-ADAM $PC-ADA
XXX.EW.COMPILER_STD,1.01:exclude_grp:0:$PC-GUEST
XXX.EW.DEBUGGER_STD,1.01:include_grp:2:$PC-ADAM $PC-ADA
XXX.EW.DEBUGGER_STD,1.01:exclude_grp:0:$PC-GUEST

Note that a license normally has a number of features. You can find the feature names 
and versions in the IAR License Manager. Double-click a product to open the License 
Details dialog box.

2 Save the file as, for example, 
C:\IARSystems\LicenseManagement\lreserv.txt.

3 Use the LSRESERV environment variable to set the destination of the user group file.

For example: LSRESERV=C:\IARSystems\LicenseManagement\lreserv.txt

4 Restart the license server.

5 Using the license is now restricted according to your specification:

● If the number of reserved tokens for the group is the same as the number of users 
allowed for the license, no one outside the group can use the license.

● If the number of reserved tokens for the group is zero, no one in the group can use 
the license.

feature_name is for example, XXX.EW.COMPILER_STD.

feature_version is for example, 1.01.

group_name is a name that identifies the group.

reserved_tokens is the number of license users reserved for the group.

user_1...user_N is a list of user names or host IDs, separated by white space.
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Logging license server activities
You can activate logging of a license server’s activities. Typically, this is useful for 
monitoring which users are using which licenses and how much.

These tasks are described:

● Enabling the logging, page 39

● Specifying the size of the log files, page 39

● Backing up the log files, page 39

● Disable backing up log files, page 40

● The log file format, page 40

ENABLING THE LOGGING

To enable logging, set this environment variable on the license server computer: 
LSERVOPTS=-l path_to_log_file

For example: LSERVOPTS=-l C:\ServerLog\logfile.txt

You must restart the license server for the changes to take effect.

Note: If the environment variable is set globally (for example in Windows system 
properties), it might affect other products.

SPECIFYING THE SIZE OF THE LOG FILES

Use the -z option to specify the maximum size of the log file. The size can be specified 
in bytes, for example -z 2000 for 2000 bytes, in kilobytes, for example -z 2k for two 
kilobytes, or in megabytes, for example -z 2m for two megabytes.

For example: LSERVOPTS=-z 2m -l C:\ServerLog\serverlog.txt

BACKING UP THE LOG FILES

If the maximum size of the file is reached, as specified by the -z option, the license 
server copies (renames) the original log file to a backup file, which has the same name 
but with two numeric digits appended to its name. The logging continues in the file with 
the original name.

Assume this example:

The administrator has specified the maximum size of the log files as 2 Mbytes. When 
the size reaches 2 Mbytes, the license server adds a suffix at the end of the log files. For 
example: serverlog.txt.00, serverlog.txt.01, serverlog.txt.02 up until 
serverlog.txt.99. Once this limit is reached, the license server starts generating the 
backup files using the same log file name series starting from 00, which means the old 
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log files will be overwritten. If you need more log files, you must write your own script 
which will back up the first 100 log files to another location (storing the content), which 
means it is no longer a problem when the first log files are overwritten.

DISABLE BACKING UP LOG FILES

To disable the automatic backing up of log files, add the -x option to the LSERVOPTS 
environment variable on the license server computer.

THE LOG FILE FORMAT

The log information is recorded in the log file, one entry per line in this format:

A typical entry might appear as:

# Startup Sentinel RMS Development Kit v7.00 Fri Aug 13 17:33:31 
1999  934590811 jsmith 140 4294489039

Element Description

Server–LFE Customer-defined log file encryption level as specified by the license 
server -lfe option.

License–LFE Vendor-defined log file encryption level. If this is non-zero, this element 
overrides Server–LFE.

Date The date the entry was created, in the format: Day-of-week Month Day 
Time (hh:mm:ss) Year, for example Wed Oct 10 08:40:46 2012.

Time-stamp The time stamp of the entry.

Feature The name of the feature.

Ver The version of the feature.

Trans The transaction type. 0 indicates an issue, 1 a denial, and 2 a release.

Numkeys The number of licenses in use after the current request/release. 
(Encrypted if encryption level is set to 3 or 4.)

Keylife How long, in seconds, the license was used. Only applicable after a 
license release.

User The user name of the application associated with the entry.

Host The host name of the application associated with the entry.

LSver The version of the Sentinel RMS Development Kit license server.

Currency The number of licenses handled during the transaction. (Encrypted if the 
encryption level is set to 3 or 4.)

Comment The text passed in by the license application.

Table 2: The log file elements 
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2 0 MTI1 Fri Aug 13 17:33:33 1999  934590813 99 v 0 1 0 jsmith 
jsmith 7.00 1 - MA== 754986 OTM1MzQ1Nzk5

2 0 MTI1 Fri Aug 13 17:33:33 1999  934590813 99 v 2 0 0 jsmith 
jsmith 7.00 1 - MQ== 905242 MTY2MDIyOA==

# Shutdown Sentinel RMS Development Kit v7.00 Fri Aug 13 17:33:34 
1999  934590814 jsmith 4294489039 Mg== 2058783
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Reference information on 
the IAR License Manager
This chapter describes how to use the IAR License Manager—a tool for 
managing your IAR Systems product licenses.

Reference information
This section gives reference information about these windows and dialog boxes:

● IAR License Manager main window, page 43

● Available Renewals dialog box, page 47

● Check for License Renewals dialog box, page 48

● License Details dialog box, page 49

● Servers dialog box, page 51

IAR License Manager main window 
The IAR License Manager is available from the Help menu in your IAR Systems 
product. Alternatively, the IAR License Manager is also available from the Windows 
Start menu.

Use this window to manage your IAR Systems product licenses.
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File menu

The menu contains this command:

View menu

The menu contains these commands:

License menu

The menu contains these commands:

Exit Exits the IAR License Manager.

Refresh Updates network license usage information, dongle status, 
etc. This is automatically done every 15 seconds.

Product List Opens the Product List page in the display area, which lists 
all installed products. Double-click a product in the list to 
display a dialog box where you can get detailed information 
about the licenses for that product, see License Details dialog 
box, page 49.

Network Licenses Opens the Network Licenses page in the display area, which 
lists all available network licenses.

Network License Users Opens the Network License Users page in the display area, 
which lists all users on the local network using network 
licenses.

Dongle List Displays a dialog box where all connected dongles are listed.

Activate License Starts the License Wizard to activate a license using a 
license number.

Use Network License Starts the License Wizard to start using a network license 
from a license server.

Get Evaluation License Starts the License Wizard to get an evaluation license.

License Details Displays the License Details dialog box, see License 
Details dialog box, page 49.

Servers Displays the Servers dialog box which lists all 
automatically identified servers and manually added 
servers. See Servers dialog box, page 51.
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Tools menu

The menu contains these commands:

Windows menu

The menu contains this command:

Check for License 
Renewal

Displays the Check for License Renewals dialog box, see 
Check for License Renewals dialog box, page 48.

License Transfer Displays the License Transfer dialog box where you can 
select a PC-locked license that you want to transfer to 
another computer. Note that this command can only be 
performed a limited number of times per year.

Offline Activation Starts a wizard for activating your license when your license 
server cannot access the internet.

For more information, see Activating your license while 
offline, page 26.

Offline License Transfer Displays a dialog box where you can choose to deactivate 
your license even if your computer is not connected to the 
internet. Typically, you do this if you want to transfer your 
license to another computer.

For more information, see Transferring your license to 
another computer while offline, page 31.

Options Displays the Options dialog box, where you can re-enable all 
previously suppressed dialog boxes.

Extract Optional 
Packages

Extracts source code libraries that were delivered with your 
product.

Close Closes the currently selected page in the display area of the 
IAR License Manager main window.
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Help menu

The menu contains these commands:

Context menu (product list)

This context menu is available on the Product List page:

These commands are available:

Collect Diagnostic 
Information

Displays the Collect Diagnostic Information dialog box and 
starts collecting diagnostic information. The progress is 
displayed in the dialog box. When finished, click Explore 
Results to view the information. Typically, this information 
can be useful if you contact IAR support.

Installation and 
Licensing Quick 
Reference

Opens the Installation and Licensing Quick Reference 
booklet as a PDF.

Licensing Guide Opens the Licensing Guide as a PDF.

About Displays information about the IAR License Manager.

License Details Displays the License Details dialog box, see License Details 
dialog box, page 49.

Check in Checks in a network license which you previously have 
checked out with commuter authorization.

Check out Checks out a network license with commuter authorization 
which means you can use it as a PC-locked license for a 
limited time.
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Context menu (network licenses)

This context menu is available on the Network License page:

This command is available:

Available Renewals dialog box 
The Available Renewals dialog box is displayed when the Check selected licenses 
button has been clicked in the Check for License Renewals dialog box. 

This dialog box lists any new versions available for the licenses selected in the Check 
for License Renewals dialog box.

The IAR License Manager contacts IAR Systems to check whether the local licenses are 
up to date. If there are any new versions available, you will get the opportunity to renew 
them.

See also Renewing a network license, page 34.

Display area

Lists licenses in these columns:

Delete Deletes the selected network license from the server. This can 
only be performed on the license server computer.

Checkbox Select the license you want to renew.

License Number The license number for the product.

Product The name of the product.
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Buttons

Check for License Renewals dialog box 
The Check for License Renewals dialog box is available from the View menu in the 
IAR License Manager. 

This dialog box lists the currently used license for each installed IAR Systems product 
on the local machine, and the installed licenses on the local license server (if any).

See also Renewing a network license, page 34.

Display area

Lists licenses in these columns:

Comment Information about the license.

Renew selected Renews the selected license.

Check Select the license for which you want to check for new licenses 
and click Check selected licenses. The Available Renewals 
dialog box is displayed if there are any new licenses.

License Number The license number for the product.

Product The name of the product.

Expiry Date The date for the license expiration.

Comment Information about the license.
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Show unused licenses

Lists also unused licenses, in other words, licenses that are not currently selected for use. 
Typically, this option can be useful if you are using a temporary license that you have 
received from IAR Systems support. When you receive an update, you must select this 
option before you can select your ordinary license for renewal.

Buttons

License Details dialog box 
The License Details dialog box is displayed when you double-click on a selected 
product in the Product List in the IAR License Manager. 

Use this dialog box to choose between available licenses and to get detailed information 
about the selected license.

Selected license

Lists all licenses that you have activated for this product and available network licenses. 
Select the license that you want to use.

Check selected licenses Checks whether there are any new licenses available for 
the licenses selected in the Check column.
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Description

Lists detailed information for the selected license.

Features

Displays all licensable features in the product and their license status in these columns:

Buttons

These buttons are available:

Hide replaced licenses

Hides replaced licenses. A license is replaced when you renew your licenses, for 
example when you replace the startup license with the permanent license or when you 
activated a later version. Note that the replaced licenses are still available.

Feature The name of the feature

Feature name The internal feature name.

Version The feature version of the installed product component.

License Version The version of the license. It must be greater than or equal to the 
version of the installed feature.

License Type The license type.

Expires Can be either:

● The expiration date, for time-limited licenses

● Permanent, for permanent licenses.

Status The status of the license; either OK or an error message.

Check Out Checks out a network license with commuter authorization 
which means you can use it as a PC-locked license for a limited 
time.

Check In Checks in a network license which you previously have checked 
out with commuter authorization.

Transfer License Deactivates the selected license, which means that you can 
activate it on another computer. Note that this command can 
only be performed a limited number of times per year.
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Servers dialog box 
To open the Servers dialog box, choose License>Servers in the IAR License Manager. 

Use this dialog box to manually point out license servers that the IAR License Server 
for some reason does not automatically detect.

Note that manually added non-existing servers will seriously increase response times in 
the IAR License Manager.

Use broadcasts to find servers

Enables broadcasts to find servers automatically on a subnet. If you disable this option, 
you must manually add the servers that you want to use. All references to automatically 
found servers will be removed.

Found servers

Lists automatically detected license servers.

Manually added servers

Lists manually added license servers.

Buttons

These buttons are available:

Add Adds a license server to the list. Click Add and type the name 
or IP number of the license server that you want to add.
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Edit Edits the name of an already added license server. Select a 
license server and click Edit to edit the license server.

Remove Removes an already added license server. Select a license server 
and click Remove to remove the license server.
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Licensing concepts
This chapter lists terms related to licensing.

Commuter authorization
A network license that you can check out from the server and 
use as a PC-locked license for a limited time.

Entitlement
The features your license entitles you to. In other words, the 
features that will be enabled and the period they can be used 
for.

Evaluation license
A free license that is limited in time or in function. For a 
time-limited evaluation license, the same product version can 
only be evaluated once on a specific computer.

Feature
A feature in the installed software that is enabled or disabled 
depending on the entitlement in your license. There is a license 
key for each feature.

License activation
The procedure to get the license keys from IAR Systems.

License key
A string that contains information that allows the license to 
verify your entitlements.

License number
A unique identifier of a license, which is used in the license 
activation and in contact with IAR Systems support.

License package
License keys and license information stored in a file. A license 
package is created on your computer when you activate a 
license.

License registration
All licenses must be registered with IAR Systems. During 
registration, contact information about the license owner is 
collected, most notably the email address. At the end of the 
registration process an email is sent to the registered address to 
verify that it is correct.

License server
A PC with the IAR License Server installed.

License transfer
Deactivating a license and returning it to IAR Systems, to be 
able to reactivate it on another computer.

Mobile licence
A single-user license that is locked to a dongle, and thus can be 
used on any computer where the product is installed when the 
dongle is connected.

Network license
A multi-user license that is located on a license server 
computer. This license can be used by any computer on the 
local network.

Offline activation
License activation requires the IAR License Manager to 
connect to IAR Systems over the internet. If that is not 
possible, there is a backup routine called Offline activation.

PC-locked license
A single-user license that is locked to the computer hardware 
and can be used on this computer only.

Permanent license
A license without a time limit.

Product
The product is what you have bought from IAR Systems. In 
addition to the software you have installed, the documentation, 
and optionally a dongle, it is a license package that entitles you 
to use a number of the features in the software.

Startup license
A time-limited license that you get immediately when you 
activate your newly purchased product.
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